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Cautions
• No part of this document may be reproduced, stored in a retrieval system, or transmitted in any form 

or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior 

written permission of Seiko Epson Corporation.

• The contents of this document are subject to change without notice. Please contact us for the latest 

information.

• While every precaution has taken in the preparation of this document, Seiko Epson Corporation 

assumes no responsibility for errors or omissions.

• Neither is any liability assumed for damages resulting from the use of the information contained 

herein.

• Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third 

parties for damages, losses, costs, or expenses incurred by the purchaser or third parties as a result of: 

accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this 

product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation’s operating 

and maintenance instructions.

• Seiko Epson Corporation shall not be liable against any damages or problems arising from the use of 

any options or any consumable products other than those designated as Original EPSON Products or 

EPSON Approved Products by Seiko Epson Corporation.

Trademarks
EPSON and ESC/POS are registered trademarks of Seiko Epson Corporation in the U.S. and other 

countries.

MS-DOS, Microsoft, Win32, Windows, Windows Vista, Windows Server, Visual Studio, Visual 

Basic, Visual C++, and Visual C# are either registered trademarks or trademarks of Microsoft Corpo-

ration in the United States and other countries. 

ESC/POS® Command System
EPSON has been taking industry’s initiatives with its own POS printer command system (ESC/POS). 

ESC/POS has a large number of commands including patented ones. Its high scalability enables users 

to build versatile POS systems. The system is compatible with all types of EPSON POS printers (excluding 

the TM-C100) and displays. Moreover, its flexibility makes it easy to upgrade the future. The functionality 

and the user-friendliness is valued around the world.

Copyright © 2012-2013 Seiko Epson Corporation. All rights reserved.
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For Safety

Key to Symbols

The symbols in this manual are identified by their level of importance, as defined below. Read 

the following carefully before handling the product.

Restriction of Use
When this product is used for applications requiring high reliability/safety such as 

transportation devices related to aviation, rail, marine, automotive etc.; disaster prevention 

devices; various safety devices etc; or functional/precision devices etc, you should use this 

product only after giving consideration to including fail‐safes and redundancies into your 

design to maintain safety and total system reliability. Because this product was not intended for 

use in applications requiring extremely high reliability/safety such as aerospace equipment, 

main communication equipment, nuclear power control equipment, or medical equipment 

related to direct medical care etc, please make your own judgment on this product’s suitability 

after a full evaluation.

Provides information that must be observed to avoid damage to your equipment or a 

malfunction.

Provides important information and useful tips.
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About this Manual

Aim of the Manual

This manual is aimed to provide all the necessary information for development engineers to 

develop, design, and install system, or to develop and design printer applications.

Manual Content

The manual is made up of the following sections:

Chapter 1 PDS Overview

Chapter 2 Using the PDS

Chapter 3 Reference

Chapter 4 TM Flash Logo Setup Utility Ver.3

Chapter 5 Printer Specification

Chapter 6 Restrictions
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PDS Overview
Introduction

The Printer Driver for TM‐S Series(PDS) is a printer driver for TM‐S9000.

The thermal printer for roll paper printing and the ink jet printer for cut sheet printing are 

installed. Compatible drivers with EPSONʹs former models are provided.

Manual organization

Install Manual
Descriptions of the procedures from installing the PDS to performing test print, adding printer 

drivers, and the silent install which is an automated PDS installation. 

Driver Manual
This manual. Descriptions of how to use the PDS and its functions. 

Devmode API / PRINTERINFO Manual
Descriptions of how to configure some device functions on your application using the Devmode 

API. Descriptions of the PRINTERINFO Function of Windows. 

Inquiries
See the Epson homepage.

• For customers in North America, go to the following web site.
http://www.epsonexpert.com/ 

• For customers in other countries, go to the following web site.
http://www.epson‐pos.com/
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PDS Features 

Easy 
• Allows you  to print  from commercially available applications, since  the PDS  is a Windows 

driver. 

• Allows you to print a Barcode and 2D‐Code with the fonts built in the PDS. 
(ʺPrinting a Barcodeʺ on page 21)

• Allow you to print logos and graphics. (ʺPrinting a Logoʺ on page 32)

• Allows you to send the paper cut command to the product. 
(ʺPaper Feed and Paper Cutʺ on page 35)

• Allows you to sound the buzzer.(ʺOption buzzerʺ on page 80)

• Allows you  to  select  from 24  languages  for  text on  screen and help dialog.  (ʺLanguage  for 

displaying propertiesʺ on page 85)

• Using  a  compatible  driver  enables  printing  on  TM‐S9000 with minimum  changes  in  the 

application to print on other TM printer.(ʺUsing Compatible Driverʺ on page 42)

Fast 
• Achieves high speed printing using the Device fonts of the product. 

(ʺCharacter Printing (Device Font)ʺ on page 15)

• Allows you to convert the Windows fonts to the Device fonts. 

• Allows  you  to  print  an  image  such  as  a  store  logo  faster  by  registering  the  image  in  the 

product. (ʺPrinting a Logoʺ on page 32)

Expandability 
• Device sharing is supported. Allows you to share product with other computers on a network. 

(Device sharing through a print server is not supported.)

• Allows you to use ESC/POS commands control. (ʺHow to Use ControlA Fontʺ on page 39)
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Programming
• Status API is not supported.

• It can be printed as any name from your application by specifying the device font. 
(ʺPrinter font advanced settingʺ on page 100)

• Character  size,  font,  and  other  settings  that  affect  the  print  result  can  be  adjusted  with 

minimal changes to your print application.  (ʺAdvanced Font Settingsʺ on page 17)

Installation 
• Allows you to copy the existing settings of the PDS environment to other computers. (Silent 

Install) 

• After  the PDS  installation,  the printer driver will be automatically  installed  to  the product 

equipped with a USB interface by the Plug and Play function. 

Printing Example 

In Terminal Service / Citrix XenApp environment, PRINTER_INFO_2 cannot be used.

 Printing a Logo

 Character Printing (Device Font)

 Printing a Barcode

 Paper Feed and Paper Cut

CHECK NO : 00000000

PAY, ****** to GENTS ******

TO THvE
ORDER
OF

NAGANO
MATSUMOTO
111-1111 JAPAN

00000 00000000 00000000

AMMOUNT:$ *** 10,000 ***CASH DEVINED
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Differences Depending on the OS
The content of the descriptions of some operations in this book may be different depending on 

the OS. See the following.

Item Description
Screens shown Screens in Windows Vista are used for the descriptions in this manual.

Setting a printer driver

Windows 8

[Desktop] - Sidebar [Settings] - [Control Panel] - [Hardware and Sound]
 - [Devices and Printers]

Right click the printer driver, and select the [Printer properties].

Windows 7
[Start] - [Control Panel] - [Hardware and Sound] - [Devices and Printers]

Right click the printer driver, and select the [Printer properties].

Windows Vista
[Start] - [Control Panel] - [Hardware and Sound] - [Printer]

Right click the printer driver, and select the [Properties].

Windows XP
[Start] - [Control Panel] - [Printers and Faxes]

Right click the printer driver, and select the [Properties].

Windows 8
How to start the 
application

Click [Start], then [All apps], and select the application you want to use            

from the list.

Windows 8 

How to display hidden 
folders

[Desktop] - Sidebar [Settings] - [Control Panel] - [Appearance and         

Personalization] - [Folder Options]

On the "Folder Options" screen, select the [View] tab.

Select "Show hidden files, folders, and drives", then click the [OK]          

button.
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Using the PDS
This chapter explains how to use the functions contained in the PDS. 

Application Device Settings 
The following explains the initial device settings from the Windows application to the product. 

Set the device model and paper from the application you are to use. 
This is an example using WordPad. Run [All Programs] ‐ [Accessories] ‐ [WordPad] from the 

[Start] menu. 

 Administrator permission is required for property settings of the printer driver.

When printing a device font in Microsoft Word, the following setting is necessary.

 For Word 2003 or earlier : From [Tools] - [Options] - [Compatibility], select "Microsoft 

Word 6.0/95" in [Recommended Options for] or make a check in "Use printer metrics to 

lay out document" in [Options].

 For Word 2007 : From [Word Options] - [Advanced] - [Compatibility Options for], select 

"Microsoft Word 6.0/95" or  "Custom" in [Lay out this document as if created in], and 

make a check in "Use printer metrics to lay out document" in [Layout Options].

(1)

Cutsheet paper width

(2)

(3)

1. Printer driver specification

Select [File] ‐ [Print...] to display the print 

dialog box. Select the printer driver you 

are to use. Press the [Apply] button, then 

press the [Cancel]. Return to WordPad 

screen. 

2. Page Setup

Select [File] ‐ [Page Setup] to display the 

Page Setup dialog box. 

Select the paper you are to use. At this 

point the Page Setup illustration changes 

to roll paper. Set the margins, and then 

press the [OK] button. 

3. Exit Settings

The paper width selected with Page Setup 

is applied to WordPad. 

Image of the page
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Character Printing (TrueType fonts) 
Printing is performed with the TrueType fonts (Arial, Times New Roman, etc.) available with 

Windows. You can apply italic and other character modifications, and freely change the font size. 

You can also print almost exactly what you see on screen. 

Specify TrueType font, Point and Style for print data. 



Chapter 2   Using the PDS

15

2

Character Printing (Device Font)
Device Font is the font set built into the device. 
You can obtain text quality in line with the performance of the device. 
You can print text at a higher speed than TrueType font. 
To print Device Font in a .NET environment, you must replace the font.  See "Device Font 

Printing in a .NET Environment" on page 26 for details. 

Setting Device Font 

When printing with Device Font, set the Device Font type. 

Device Font Type
The xx after the font name specifies two digits, expressing the character size. 
Font with [255] after the font name is user‐defined pages. See the Technical Reference Guide for 

the product you are using for a description of this setting. 
Also see the manual regarding the number of dots for each font.  
Some fonts are not supported, depending on the model of product. See ʺPrinter Specificationʺ for 

details. 

• FontAxx

• FontBxx

Device Font Size 
Device Font prepares fonts for each character size. As with TrueType fonts, point size is not 

specified separately from the font; rather, character size is specified by selecting a font. 

The following sizes are available with Device Font. 

Width \ Height Standard Double Fourfold Eightfold
Standard FontA11 FontA12

Double FontA21 FontA22 FontA24

Fourfold FontA42 FontA44 FontA48

Eightfold FontA84 FontA88

FontA22

FontA11

Double height

Standard

Double width

Double height / width

FontA12
FontA21
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Printing Method 

Specify Device Font, specified Point (check with [Font] tab) and language in print data. 

Program

The following is an example program for reference.

----------------------------------------------------------------
Printer.Font.Charset = 0
`Font
Printer.Font.Name = "FontA44"
`Size
Printer.Font.Size = 38.5
`Printing text
Printer.Print "EPSON"

----------------------------------------------------------------

 Not reflected in characters even when you specify bold/italic. The underline is printed but 

the position is offset. 

 Printing is not possible when Device Font and Barcode(2D-Code) Font are arranged in 

one line.

The character design and size displayed on the application screen are a little different from 

actual printing results. 
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Advanced Font Settings

When developing a print application, fine adjustment of the print layout is often necessary and 

font names must be changed when the device is changed. By configuring advanced settings for 

fonts, the desired print results can be obtained with minimal setting changes in the application.

Alias Setting

 An alias name can be specified for a printer font. This enables printing using the printer font 

without changing the font name in the application.

Printer Font Substitution

 This substitutes TrueType fonts for printer fonts. The TrueType fonts are adjusted to the size of 

the printer fonts to minimize disruption of the text layout. Proportional fonts are printed as 

fixed‐width fonts. Select this setting when small differences in font sizes cause disruption of 

the layout.

Register Emulation Font

 Any font name, font size (height and width in dots), and font design (TrueType font) can be 

specified. Use these settings when you wish to change a font name and font size.

Follow the steps below to open the “Printer font advanced setting” screen.

1 Select the [Font] tab from Printing Preferences. Click the [Advanced 
settings] button.
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2 The “Printer font advanced setting” screen appears.

If the [Printer Font Substitution] tab does not appear when using the devise, select the 

[Document Settings] tab from the print settings and set [Print all text as graphic images] to [Yes].
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Alias Setting
Select the [Alias Setting] tab. Select the font from the [Modifiable printer font] list, and specify 

the alias name. When finished, click the [OK] button. 
For example, by setting an application font name to an alias name for printer font ‐ ”FontA11”, 

text can be printed using “FontA11” without changing the application.

Printer Font Substitution
Select the [Printer Font Substitution] tab. Select a font from the [Printer font list], and select the font 

form (TrueType font) that you wish to substitute for it. When finished, click the [OK] button.

For example, when “Arial” is substituted for “FontA”, specifying “FontA11” in the application 

will print text in Arial font at the size of “FontA11”. The font size is adjusted to the same size as 

the printer font. This setting allows a 180 dpi printer to print 46 Arial font characters per line on 

80 mm width roll paper.

Printer font used for 
printing

Font name specified in 
application

Font used for printingFont name specified 
in application
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Register Emulation Font
Select the [Register Emulation Font] tab. Enter the name of the emulation font you wish to register 

and specify the font form to be substituted (TrueType font). Enter the width and height. When 

finished, click the [OK] button.

The emulation font registration function makes it easy to adjust the print layout. In addition, 

when the device is changed in an existing application, printing is possible using the previous 

text size and layout without changing the application.

If the text size is too small or the height-width ratio is too large, the characters may be 

blurred. Be sure to check the print result carefully before using this function.

Font size

Font used for printingFont name 
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Printing a Barcode
PDS has Barcode font built in. Therefore, you can print Barcode even if you have not created 

Barcode on the application side. 

Barcode font lets you register the Barcode type and size as properties. Up to eight types of 

Barcode (Barcode 1 ~ 8) can be registered using the PDS.  

Barcode font setting 

Select the Barcode tab from Printing Preferences. 

Make the following settings. See ʺBarcodeʺ on page 86 for details. 

When used in combination with Rotation, set a slow Printing Speed with the [Document 

Settings] tab. When the print speed is too fast, the barcode may not be read.

Setting Description

Font Name
You can set Barcode font for up to 8 Barcode types (Barcodes 1 ~ 8). 
When printing through an application, specify the font name or the 
alias name.

Points
The Barcode font s ize is displayed. When pr inting through an         

application, specify this value.

Alias
You can make optional settings. You can specify Alias dur ing         
programming. 

HRI characters

Element width
(width of the thin lines in dots)

Barcode type

Alias

Open the 
Advanced settings 

Element

HRI characters

Rotation

Quiet Zone

Barcode tab

Font Name

Element height
(height of the thin lines in dots)

Points
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Printing Method 

Specify Barcode Font, specified Point (check with [Barcode] tab) and language in print data. 

Type Configures the Barcode type (UPC-A, Code39, etc)

Element
Determines the Barcode size. Specifies the finest Element width and         
height. Units are the smallest dot of the product. This result determines           
the Barcode font Point. 

HRI characters Sets with/without HRI characters, position and font. 

Rotation Sets whether to independently rotate Barcode. 

Hex Input Mode Allows the Barcode characters to be entered in binary. 

Add Quiet Zone
The blank margin on either side of a Barcode required in order to read             
the Barcode. 

When Rotate is set with the [Layout] tab, the printing direction of the Barcode matches 

[Layout] tab Rotate and the Rotation of [Barcode]-[Advanced settings] printing direction. 

Ex: When specifying [Rotate by 90 degrees] with [Layout] Rotate and [Rotate by 90 

degrees] with [Barcode] Rotation, the printing direction is turned through 180 degrees. 

Barcode Font Points determined. Check with Printing Preferences - [Barcode]. When 

specifying a value other than this, the Barcode is not printed. 

The character design and size displayed on the application screen are a little different from 

actual printing results. 

Setting Description
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Program

The following is an example program for reference.

----------------------------------------------------------------
Printer.Font.Charset = 0
`Size
Printer.Font.Size = 18.5
`Font
Printer.Font.Name = "Barcode1"
`Printing text
Printer.Print "12345678"

----------------------------------------------------------------
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Printing a 2D-Code
PDS has a 2D‐Code font. Therefore, you can print 2D‐Code without creating 2D‐Code on the 

application side. 

The 2D‐Code font allows registration of 2D‐Code type and size properties. 

Up to eight types (2D‐Code 1 ~ 8) of setting can be registered using the PDS. You can make fine 

settings of 2D‐Code at one time, and also easily change the settings. 

Setting the 2D-Code Font 

Select the 2D‐Code tab from Printing Preferences. 

Make the following settings. See ʺ2D‐Codeʺ on page 89 for details. 

Set a slow Printing Speed with the [Document Settings] tab. When the print speed is too 

fast, the symbols may not be read.

Setting Description

Font Name
You can set the 2D-Code font from the 8 types of 2D-Code(1 ~ 8). 
When printing through an application, specify the font name or the 
alias name.

Points
The 2D-Code font size is displayed. When pr inting through an         

application, specify this value.

2D-Code types

Alias

Open the 
Advanced settings 

Advanced setting

Rotation

Quiet Zone

2D-Code tab

Font Name

Points
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Printing Method 

Specify 2D‐Code Font, specified Point (check with [2D‐Code] tab) and language in print data. 

Alias
You can put a name to 2-dimensional symbol fonts. Through an 
application, you can specify a font by this alias name instead of 
specifying 2-dimensional symbol font itself.

Type Sets the type. (PDF417, MaxiCode, etc.)

Advanced setting
Sets the 2D-Code size and Error Correction Level, etc. Setting contents          
differ with the 
2D-Code type. 

Rotation Sets whether to independently rotate 2D-Code. 

Hex Input Mode Allows the 2D-Code characters to be entered in binary. 

Add Quiet Zone
Check this box to add a quiet zone, the blank margin on either side of a               
2D-Code required to be properly read. 

When Rotate is set with the [Layout] tab, the printing direction of the Barcode matches 

[Layout] tab Rotate and the Rotation of [Barcode]-[Advanced settings] printing direction. 

Ex: When specifying [Rotate by 90 degrees] with [Layout] Rotate and [Rotate by 90 

degrees] with [2D-Code] Rotation, the printing direction is turned through 180 

degrees. 

2D-Code Font Points determined. Check with Printing Preferences - [2D-Code]. When 

specifying a value other than this, the 2D-Code is not printed. 

Setting Description
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Device Font Printing in a .NET Environment
.NET Framework supports only TrueType and OpenType fonts. Therefore, the printer’s device 

fonts cannot be used. In the PDS, therefore, a font substitution function is provided to allow you 

to use device fonts even with .NET Framework. 
This function is not only useful in a .NET Framework environment: it also allows you to use the 

device fonts from an application that only supports TrueType fonts. 

Substituting Fonts

The PDS font substitution function replaces a TrueType font with a device font. By specifying a 

device font to be used as a substitute for a given TrueType font, printing can be done using a 

device font. True Type fonts are used for the applicationʹs screen display, but they are substituted 

by the device font when printed.

For TrueType fonts not available for the substitution, see the table below. 

TrueType fonts not available for the substitution
Marlett Symbol MS Outlook Wingdings 3

Wingdings Webdings Wingdings 2

Images on an application screen cannot be printed as it is because device fonts differ from 

TrueType fonts in characteristics such as the aspect ratio. You need to confirm print results 

in advance.

Device fonts whose horizontal/vertical ratio is different, such as FontA 12/21, cannot be 

printed. 

PDS

.NET Framework

ABC
Application

Printing

Substituting fonts

ABC

ABC

(TrueTypeFont)

Display

Screen display

Print

(TrueTypeFont)

ABC

ABC
(DeviceFont)

(TrueTypeFont)

(DeviceFont)
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Font Substitution Settings

Make the Substitution setting as follows. See ʺTrueType Font Substitutionʺ on page 84 for details. 

1 Select the Printer Settings tab from Printing Preferences. 

2 Select [True Type Font Substitution] from the selection items.

3 Select [Substitute] and click the [Advanced Settings] button.

4 The TrueType Font Substitution screen is displayed. Select a TrueType font 
to be substituted.

5 From the pull down list, select the device font with which you substitute 
the TrueType font.
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Printing Using a Device Font

Even if you specify bold or italic font settings to the text in TrueType font, it will not be 

reflected in the printings. The underline is printed but the position is offset. 

Select the TrueType font to be substituted.

Font Substitution Settings

For the print data, specify a TrueType font and size.
(Specify the size of the device font using that of the TrueType font.)

That TrueType font for which substitution has been specified will always be output as 
the device font. Otherwise, therefore, always select another TrueType font. 

Make the [Printer Settings] ‐ TrueType Font Substitution settings. The example 
specifies Arial for font substitution. (See ʺSubstituting Fontsʺ on page 26.)

Specify the font size by adding 1 point to the size in the [Font] tab and dropping the 
fractional part.
Example: If the device font size is 9.5pt, specify 10.0pt.

Note:

• If  characters does  not  fit  in  one  line  and  are  printed  on  the  next  line,  specify  a 
smaller  point size for the TrueType font.

• Only device fonts whose vertical/horizontal ratio is same, such as FontA11/22, can 
be printed. 

• Smaller  fonts whose point  sizes are  smaller  than  that of  the  smallest device  font 
(example: FontA11) cannot be printed.

• If a point size between those of FontA11 and FontA22 is specified for the point size 
of the TrueType font, the smaller device font will be printed.

Print

You need to confirm print results with your application in advance.
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Program
The following is an example program for reference.

----------------------------------------------------------------
Printer.Font.Charset = 0
`Font
Printer.Font.Name = "Arial"
`Size
Printer.Font.Size = 38.5
`Printing text
Printer.Print "EPSON"

----------------------------------------------------------------

Printing Barcodes/2D-Code Fonts

Select the TrueType font to be substituted

Font Substitution Settings

For a character string printed using a Barcode/2D‐Code font, 
specify a TrueType font and size

• That TrueType font for which substitution has been specified will always be output 
as the device font. Make sure to select TrueType font that you will not use for other 
than the Barcode.

• Wide fonts such as FONT A12/24/48, and tall fonts such as FONT A21/42/84 cannot 
be substituted.

Make the [Printer Settings] ‐ TrueType Font Substitution setting. 
(See ʺSubstituting Fontsʺ on page 26.)

Specify a point size specified on the [Barcode]/[2D‐Code] tab. Note that the layout will 
be adversely affected if you specify a point size other than one of those shown here.

Print

You need to confirm print results with your application in advance.
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Controlling the Product(Device): Control Font/Control A Font

Select the TrueType font to be substituted

Font Substitution Settings

Specify the TrueType font and size for the control font/control A font for print data.

• Select a TrueType font to be used as a control font.

• That TrueType  font  for which  substitution has been  specified  cannot be used  as 
other than the control font. If you specify this font for any other characters, not only 
will printing fail, but the system may operate as if another command had been 
specified. Therefore, make sure to select TrueType font that you will not use as 
other than the control font.

Make the [Printer Settings] ‐ TrueType Font Substitution setting. 
(See ʺSubstituting Fontsʺ on page 26.)

Specify a point size shown on the [Font] tab.

The point size may be too small to be recognized on the application screen.

You need to confirm print results with your application in advance.

Print
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Background printing
Use Water Mark to print background. A bitmap file is necessary for Water Mark setting. 

Water Mark setting

Select the Water Mark tab from Printing Preferences. 

Make the following settings. See ʺWater Markʺ on page 67 for details. 

 You may not be able to print a Water Mark depending on the application. 

 When the printing orientation setting is other than standard, since [Print all text as 

graphics] under Document Settings is "Yes" you cannot use Device Font, Control Font 

control (logo printing using NV memory, etc.) or ControlA Font. 

 When printing in the shared printer environment, save the  data file in a folder accessible 

from the shared environment.

Setting Description

Water Mark
Check to print Water Mark. When checked, [Print all text as          
graphics] under Document Settings is automatically set to "Yes". 

Bitmap Specifies the background bitmap data file. 

Print Position Make the following settings. 

Size Configures the size of the Water Mark.

Density Configures the density of the Water Mark.

Bitmap

Water Mark tab  

Print Position 

Size

Density

Water Mark 
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Printing a Logo
Use the following method to print graphics. 

The following explains how to register a bitmap in the product and print. Method that applies 

the bitmap of a fixed format such as a store logo. 

Bitmap data registration 

Register the bitmap data in the product’s NV (Non Volatile) memory with the TM Flash Logo 

Setup Utility. This memory retains its data even when the product is switched off. 
For more details, see ʺTM Flash Logo Setup Utility Ver.3ʺ on page 103.

Bitmap data printing

The following method is for printing bitmaps registered in a product. 

Method Features
Print bitmap on the application screen Large data volume, printing is slow. 

Specify bitmap file in the printer driver for printing. Slow, because file is read each time for       
printing. 

Register bitmap in product for printing Data volume is small, therefore you can      
print fast. 

When registering a bitmap file in the shared device environment, save the data file in a 

folder accessible from the shared environment.

Method Features
Setting by printer driver Prints the bitmap in a document or before and after a page. 

Specifying by Control Font. Specifies control font at the position for bitmap printing. 
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Setting by printer driver for printing 
Select the Document Settings tab from Printing Preferences. 

Make the following settings. See ʺLogo Printingʺ on page 79 for details. 

* The Key code and graphic in the NV memory for printing are as follows. 

Setting Description
Logo Printing (printing 
area)

Specify an area for a logo printing (before or after a document or each 
page.)

Print Position Specify a logo print position. Select Left, Center, or Right.

Specifying the bitmap  
to print 

Select whether to use the logo registered in the product or to specify and 
use an image file. 

Specify logo registered  
in device* Specify a logo registered in the product.

NV graphic Specify the key code of a logo registered using TM Flash Logo Setup Utility.

NV graphics 
number

Key code

1st byte
2nd 
byte

NV graphics 0 48 48

NV graphics 1 48 49

NV graphics 2 48 50

NV graphics 3 48 51

NV graphics 4 48 52

Document Settings 
tab 

Logo Printing
(printing area) 

Select logo 
registered in 
device 

Specify the registered 
NV graphics number’s 
Key code. 

For device registered logo 
(NV graphic)
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Specify Control Font to print 
Bitmap is printed using Control Font. 

Program

The following is an example program for reference.

----------------------------------------------------------------
Printer.Font.Charset = 0
`Font
Printer.Font.Name = "control"
`Size
Printer.Font.Size = 1
`Printing text
Printer.Print "i"

----------------------------------------------------------------

2. Specify Control Font

Select the control character of the Control 

Font, and specify Control Font, Point and 

Style. 

1. Enter Control Character

Enter control character for Control Font 

NV graphics printing. 

3. Print

(3)

(1)

(2)
(2) (2)
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Paper Feed and Paper Cut
There are two methods for controlling the paper cut.

• Configure the PDS to feed and cut the paper automatically at the end of each printing.
This method is valid even when [Print all text as graphics image] is set.

• Cut the paper using Control Font in the program.

Setting paper cut with the printer driver

Select the Document Settings tab from Printing Preferences. 

Make the following settings. See ʺPaper Sourceʺ on page 72 for details. 

Making this setting controls paper feed and paper cut when printing a document. 

When using Control Font, you cannot use it in combination with a <Print all text as graphics 

image> setting such as Rotated Printing/Water Mark/Scale-down Printing.

Setting Description
Setting item Select Paper Source

Paper Source Select whether to feed paper per job (document) or page, and          
whether to cut paper with the auto-cutter or not. 

Document Settings tab 

Setting item

Paper Source
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Specifying Control Font and performing paper cut in programming. 

The following is an example program for reference.

----------------------------------------------------------------
Printer.Font.Charset = 0
`Font
Printer.Font.Name = "control"
`Size
Printer.Font.Size = 1
`Printing text
Printer.Print "P"

----------------------------------------------------------------
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Drawer Control
The methods for controlling the drawer are as follows.

• Make the drawer open automatically by configuring the printer driver.

• Open the drawer from the application using the Open Drawer Control Font.

Opening Drawer with printer driver setting 

Select the Document Settings tab from Printing Preferences. 

Make the following settings. See ʺCash drawerʺ on page 77 for details.

When using Control Font, you cannot use it in combination with the <Print all text as 

graphics image> setting such as Rotated Printing/Water Mark/Scale-down Printing.

For closing the drawer, push manually.

Setting Description
Setting item Selecting Cash drawer

Cash Drawer With a drawer provided by Epson, if you set "Open after printing" for Cash 
drawer #2 (5pins), the drawer opens after printing.

For closing the drawer, push manually.

Document Settings tab 

Setting item

Cash Drawer
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Opening Drawer by Control Font

Use the Open drawer Control Font to open Drawer. 

Program

The following is an example program for reference.

----------------------------------------------------------------
Printer.Font.Charset = 0
`Font
Printer.Font.Name = "control"
`Size
Printer.Font.Size = 1
`Printing text
Printer.Print "a"

----------------------------------------------------------------

Set "Do not open (do not send command)" for Cash Drawer in Document Settings.

2. Specify Control Font

Select the control character of the Control 
Font, and specify Control Font, Point and 
Style. 

1. Enter Control Character

Enter control character of the Open 
drawer Control Font in the position you 
want the drawer to open. 

3. Print

Drawer opens. 

(1)

(2)

(2) (2)
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How to Use ControlA Font
With the ControlA Font, ESC/POS commands can be assigned to the selected characters, and on 

printing the assigned characters can be executed as defined ESC/POS commands. 

Setting ControlA Font 

Select [Utility] from Properties, and then press the [Edit controlA font Character Translation 

Table] button. Edit controlA font character translation table is displayed.

ESC/POS commands are not open to the public. Ask your sales representative for more 

information.

When using ControlA Font, you cannot use it in combination with the <Print all text as 

graphics image> setting such as Rotated Printing/Water Mark/Scale-down Printing.

Edit controlA font Character Translation Table
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Define ESC/POS commands in the record you want to define. 

Using ControlA Font 

Use the defined ControlA Font. 

3.ESC/POS command definition

Enter ESC/POS command in Command. 
Press the [OK] after entering. 
Up to 255 bytes characters can be defined. 

1. Record selection

(2)

(1)

(3)

2. Open

Press the [Edit] button to open ControlA 
Editor.

(3)

(1)

(2)
(2)

1. Enter Control Character

Enter control character for ControlA Font. 

3. Print

ESC/POS command defined for the 

control character of ControlA font is 

executed.

2. Specify ControlA Font

Specify ControlA Font, Point and Style. 

(2)
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Program

The following is an example program for reference.

----------------------------------------------------------------
Printer.Font.Charset = 0
`Font
Printer.Font.Name = "controlA"
`Size
Printer.Font.Size = 1
`Printing text
Printer.Print "a"

----------------------------------------------------------------
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Using Compatible Driver
A compatible driver is a driver used for TM‐S9000 to emulate other TM printers (former models).

This allows printing on TM‐S9000 with minimum changes in the application to print on other 

TM printer.

TM Printer and Station Driver

The applicable TM printers are as follows.

Printer Station Driver

TM-H6000II

Receipt EPSON TM-H6000II Receipt (for TM-S9000)

Slip EPSON TM-H6000II Slip (for TM-S9000)

Validation EPSON TM-H6000II Validation (for TM-S9000)

TM-H6000III

Receipt EPSON TM-H6000III Receipt (for TM-S9000)

Slip EPSON TM-H6000III Slip (for TM-S9000)

Slip Rotate EPSON TM-H6000III Slip Rotate (for TM-S9000)

Validation EPSON TM-H6000III Validation (for TM-S9000)

TM-H6000IV

Receipt EPSON TM-H6000IV Receipt (for TM-S9000)

Slip EPSON TM-H6000IV Slip (for TM-S9000)

Slip Rotate EPSON TM-H6000IV Slip Rotate (for TM-S9000)

Validation EPSON TM-H6000IV Validation (for TM-S9000)

TM-U325
Receipt EPSON TM-U325 Receipt (for TM-S9000)

Validation EPSON TM-U325 Validation (for TM-S9000)

TM-U375

Receipt EPSON TM-U375 Receipt (for TM-S9000)

Slip EPSON TM-U375 Slip (for TM-S9000)

Validation EPSON TM-U375 Validation (for TM-S9000)

TM-U675

Receipt EPSON TM-U675 Receipt (for TM-S9000)

Slip EPSON TM-U675 Slip (for TM-S9000)

Validation EPSON TM-U675 Validation (for TM-S9000)
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Driver Coexistence
The driver coexistence environment is as follows.

How to Use

Before using a compatible driver, be sure to execute printing test adequately and adjust the print 

position and layout.

In addition, take the following points into consideration.

• The print position must be adjusted due to different printer resolution.

• The print position must be adjusted due to different printing area.

• Adjust the print position from Adjust Print Position on the Layout tab of the driver. 
The ʺ+ / ‐ ʺ direction for the adjusted value is different depending on the driver. For details, see 

the descriptions for each driver.

Combination Coexistence
Using the same device with TM-S9000 driver and a compatible driver. No

Using different devices with TM-S9000 driver and a compatible driver. Yes

Using the same device with compatible drivers for different models,
for example, TM-H6000III compatible driver and TM-U675 compatible driver.

No

Using the same device with compatible drivers for the same model,
for example, TM-H6000III Receipt compatible driver and TM-H6000III Slip 
compatible driver.

Yes

Driver Position of Origin
Slip Compatible Upper left of paper

Validation Compatible Upper left of paper

TM- S9000 Cut Sheet Paper Upper left of paper

Receipt Compatible Upper left of paper

TM-S9000 Roll Paper Upper left of paper
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Slip Compatible Driver
The print position is slightly different between the former model and the compatible driver. 

Adjust the print position from Adjust Print Position on the Layout tab.

Win

W
in

Former model Compatible Driver

Print Direction

Printing Area
nHorizontal Direction (-)

Vertical Position (+)

Adjustment of printing area
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Printing Area

TM‐S9000 can print the area shown below on cut sheets.

Device fonts cannot be printed on the area shown below.

For the printing area for each printer, see Technical Reference Guide for each printer.

235mm or les

18mm

50.8mm or les

10mm10mm

215mm or les

Print direction

Horizonal Direction(+)

Vertical Position(-)

Printing Area

Paper

13.4mm

ABCDEFG

10mm

4.9mm

18mm

50.8mm

10mm

AB
CD
EF
G

Example:TM-U375

Paper

TM-S9000

Printing Area



46

Slip Rotate Compatible Driver
The print position is slightly different between the former model and the compatible driver. 

Adjust the print position from Adjust Print Position on the Layout tab.

EPSON

EP
SO
N

Former model Compatible Driver

Print Direction

Horizontal Direction (+)

Vertical Position (-)

EP
Adjustment of printing area
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Validation Compatible Driver
The print position is greatly different between the former model and the compatible driver. 

Adjust the print position from Adjust Print Position on the Layout tab.

Win

Win

Former model Compatible Driver

Print Direction

Horizontal Direction (+)

Vertical Position (+)

Win

Adjustment of printing area
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Receipt Compatible Driver
The print position is slightly different between the former model and the compatible driver. 

Adjust the print position from Adjust Print Position on the Layout tab.

Win Win

Former model Compatible Driver

Print Direction

Horizontal Direction (+)

Vertical Position (+) Wi
Adjustment of printing area
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Reference
This chapter describes the PDS settings.

To open the setting screen of the printer driver Properties, right click the printer driver from 

[Start] ‐ [Control Panel] ‐ [Printers] and select [Properties] (Reference page of other OS.). 
Select the [General] tab on the Properties screen and click the [Printing Preferences...] button to 

open the Printing Preference screen.

 Administrator permission is required for property settings of the printer driver.

Properties Printing Preferences
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Properties
The following settings are available in the Property.

Tab Description
General Configures device name and printing preference, or makes a test print.

Sharing Configures settings for sharing the device.

Ports Configures ports settings.

Advanced Configures detailed settings for printing.

Color Management Configures color management settings.

Security Configures Windows security setting.

Utility Configures Log File and ControlA font settings.

Version Displays version information.
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General

Allows you to check/change the device name, check the print settings, and make a test print 

(Print Test Page).

Setting Description
Device Name Displays the printer driver name.

Location Accepts the device location to be input.

Comment Accepts comments about the driver to be input.

Model Displays the driver name of the device.

Features Displays functions and papers available with the device.

Printing Preferences... Displays the Printing Preferences screen.

Print Test Page Prints the Windows test page.
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Sharing

Allows you to configure the settings for sharing the device.

Device sharing through a print server is not supported.

In Windows 7 / VIsta, elevation of UAC is required.

Setting Description
Change sharing options Check this box when a device is to be shared.

Share this printer
When this box is checked, network users can access a device 
connected to this computer.

Share name Specifies the name of a shared device.
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Ports

Allows you to configure Epson Port settings.

Setting Description
Add Port... Creates a new Epson Port.

Delete Port Deletes an Epson Port.

Configure Port... Configures an Epson Port.

Enable bidirectional 
support

Do not uncheck. The PDS will become unusable.

Enable printer pooling
Enables printing to two or more identical print devices through one 
logical device.

Select the Epson Port Driver (TMSPRTxxx) to be used for printing. Do not use USB.
 The PDS works only with the Epson Port Driver.
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Advanced

Allows you to configure the detailed settings for printing. Basically, use as they are configured 

by default.

Setting Description
Always available Makes the device always available.

Available from
Configures the device for limited availability. If you send a document to 
a device when it is unavailable, the document will be held (spooled) 
until the device is available.

Priority
Indicates the current priority setting. Higher-priority documents will print 
before lower-priority documents.

Driver
Lists the name of the installed printer driver. The printer driver name 
usually corresponds to the name of the device.

Spool print documents 
so program finishes 
printing faster

Specifies that documents should be spooled before being printed.

Start printing after last 
page is spooled

Specifies that the print device should wait to begin printing until after the 
last page of the document is spooled. The printing program is 
unavailable until the document has finished spooling. However, using this 
option ensures that the whole document is available to the print device.
Configurable when [Spool print documents so program finishes printing 
faster] is set.
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Start printing 
immediately

Specifies that the print device should begin printing after the first page 
of the document is spooled. This makes the printing program available 
sooner.
Configurable when [Spool print documents so program finishes printing 
faster] is set.

Print directly to the 
device

Specifies that the document should be sent directly to the print device 
and not spooled. Use this if you cannot print using either of the print 
spooling options.

Hold mismatched 
documents

Directs the spooler to check the device setup and match it to the 
document setup before sending the document to the print device. If 
the information does not match, the document is held in the queue.
A mismatched document in the queue will not prevent correctly 
matched documents from printing.
Configurable when [Spool print documents so program finishes printing 
faster] is set.

Print spooled documents 
first

Specifies that the spooler should favor documents that have completed 
spooling when deciding which document to print next, even if the 
completed documents are a lower priority than documents that are still 
spooling. If there are no documents that have completed spooling, the 
spooler will favor larger spooling documents over smaller ones. Use this 
option if you want to maximize device efficiency.
When this option is disabled, the spooler picks documents based only on 
priority.
Configurable when [Spool print documents so program finishes printing 
faster] is set.

Keep printed documents

Specifies that the spooler should not delete documents after they are 
printed. This allows a document to be resubmitted to the device from 
the device queue instead of from the program.
Configurable when [Spool print documents so program finishes printing 
faster] is set.

Enable advanced 
printing features

Specifies whether the advanced printing feature is enabled. When 
enabled, metafile spooling is turned on and options such as Page Order, 
Booklet Printing, and Pages Per Sheet are available, depending on your 
device. For normal printing, leave the advanced printing feature set to 
the default (Enabled). If compatibility problems occur, you can disable 
the feature. When disabled, metafile spooling is turned off and the 
printing options might be unavailable.
Configurable when [Spool print documents so program finishes printing 
faster] is set.

Printing Defaults... Click to configure the Printing Preferences.

Print Processor...

Click to specify the data type. In general, you do not need to change 
either the default print processor or data type. However, a few programs 
might require a specialized print processor and a particular data type to 
print.

Separator Page... Not available.

Setting Description
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Color Management

Allows you to set color displayed on the screen.

Setting Description
Color Management Set the color management.
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Security

Security setting for Windows.

Setting Description

Group or user names
Lists the users and groups with assigned permissions for this object. 
The permissions for the highlighted group or user appear in the list box 
below.

Add If you want to add permissions for users or groups, click their names.

Remove
Removes highlighted permission entry. More than one permission entry 
can be connected with a user or group.

Permissions for 
Administrators

Permissions you can allow or deny for each user or group are listed. To 
allow or deny the permission, check or clear the appropriate check- box. 
Shaded checkboxes indicate inherited permissions. To see additional 
information on permissions or inheritance, click Advanced.

Advanced
Click for viewing and setting special permissions, auditing information, 
owner information, and permissions effective for this object.
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Utility

Allows you to use EPSON Log File Settings, Edit CotrolA Font Character Translation Table, and 

other utilities.

Some utilities may not be supported depending on the device model. In that case, the utility will 

not be displayed.

Setting Description

EPSON Flash Logo
Displays TM Flash Logo Setup Utility Ver.3 ("TM Flash Logo Setup Utility 
Ver.3" on page 103).

EPSON Log File Settings Opens the Log File Setting screen. 

Edit ControlA Font 
Character Translation 
Table

Opens the EPSON controlA font setting screen. 
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EPSON Log File Setting
Allows you to create a log file which can help you to troubleshoot a problem quickly. See the 

Status API Manual for more details about the log file. 

Setting Description

Logging
Enable (Default) Enables log output.

Disable Disables log output.

Log File 
Directory

Specify where to output the log file.

(Default)

 Windows XP:
C:\Documents and Settings\All Users\Application Data\EPSON\devicecontrollog

 Windows 7 / Vista:
C:\ProgramData\EPSON\devicecontrollog

 Windows 8
C:\ProgramData\epson\devicecontrollog 
The ProgramData folder is a hidden folder.

Log Size Limit 
(MB)

Specify the upper limit of the log file size. (Range: 10 to 1024, Default: 40)

When the upper limit is exceeded, the log file is compressed in zip format. The 
subsequent log information is saved as a new log file. The file compression date is 
used as the zip file name. (example: 201107071130.zip) 
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Edit controlA font character translation table
Allows you to edit EPSON controlA Font settings. You can assign ESC/POS commands to the 

selected controlA Font characters. When the assigned characters are printed, the corresponding 

ESC/POS commands are executed. 

 Up to 255 bytes characters can be assigned. 

 ESC/POS commands are not open to the public. Ask your sales representative for more 

information.

Setting Description
Driver Name Displays the printer driver name for which the controlA Font will be configured.

Char Displays the selected ASCII code as characters.

Hex Displays the selected ASCII code as hexadecimals.

Command
Displays the ESC/POS command corresponding to the ASCII code. It is displayed 
in hexadecimal.

Help Displays the EPSON controlA Font help.

Edit Displays the controlA Editor screen. Allows the [Command] to be edited.

Delete Deletes the [Command] selected from the list box.

OK Saves the configured settings and closes the EPSON controlA Font.

Cancel Closes EPSON controlA Font without reflecting the changes.

controlA Editor screen
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controlA Editor screen

An ESC/POS command to be assigned to the selected character can be entered.

Version

Displays the printer driver version information.

Setting Description

Char
Displays the selected ASCII code as characters. The content cannot be 
changed.

Hex
Displays the selected ASCII code as hexadecimals. The content cannot be 
changed.

Command
Enter the ESC/POS command that will correspond to the ASCII code. Enter using 
hexadecimal.
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Printing Preferences
The Printing Preferences screen is displayed by selecting the Properties ‐ [General] tab and 

clicking the [Printing Preferences...].
You can configure the following settings in the Printing Preferences screen.

Tab Description

Main
Configures basic print settings, such as the number of copies, and color 
setting.

Layout Configures paper size and rotation of print images.

Water Mark Configures Water Mark setting.

Document Settings Configures the Document Settings.

Halftone Settings Configures the Dither Type and color assignment settings.

Printer Settings Configures paper width for the device.

Barcode
Configures the Barcode settings. (Displayed only when the device supports 
the Barcode printing.)

2D-Code
Configures the 2D-Code settings. (Displayed only when the device supports 
the 2D-Code printing.)

Font Displays the list of Device fonts.
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Main

Allows you to configure the print resolution, color mode, and the number of copies.

Setting Description
Resolution The resolution of the device is specified.

Color Select [Monochrome] to print using a single color. 

Copies Configures the number of copies.

Collate Configures the number of copies of document with multiple pages.

Reverce Print Order Prints the document with multiple pages in backward order.

InkInformation Displays the InkInformation.
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Layout

Allows you to configure the paper size, rotation, and reduced print settings.

Setting Description

Paper Size

Select the paper size from list.
The list shows all the paper sizes (including the logic paper 
sizes and user defined sizes) supported by the printer driver.

Paper size The sizes of paper which can be set in the device.

Logic paper size

The original size of a print image which can be scaled 
down by the printer driver. 
An image is scaled down to the size of paper loaded on 
the device.

User Defined Paper 
Size

The paper size defined by the users. 
Setting the paper size can be made in the User Defined 
Paper Size screen.

Output Paper Displays paper types available with the device.

Adjust Print Position

Allows you to fine adjust the print start position. You can          
adjust the print position without making changes in       
margins and print area defined by the applications. This        
also can be used for changing print position of rotated or          
reduced image. 
This adjustment is limited within the printable area of the         
selected [Paper Size]. If you change the [Paper Size] to the          
smaller one without changing the print position setting,       
causing the position settings to fall outside the new        
printable area, the settings will be automatically changed       
so that the print image fits inside the new printable area.
The print position of the logo registered in the device         
(NV Graphics) will not be changed.

User defined paper size settings.
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* Reduced Print setting does not change the size of Barcode and 2D-Code.

Vertical Direction
This adjusts the print position in horizontal direction.
 Enter a negative value to make the top margin smaller, or 
positive value to make it larger.

Horizontal Direction
This adjusts the print position in vertical direction.
Enter a negative value to make the left margin smaller, or 
positive value to make it larger.

Rotate

This configures print direction. 
The graphic shown on the right changes according to the 
selected setting. Select a desired setting for rotating a print 
image. When other than [Normal] is selected, the following 
message is displayed; "<Print all text as graphics image> 
will be automatically set to yes. <Paper Conservation> will 
be automatically changed.". 

Normal This prints in normal direction. This is the default.

Rotate by 90 Degrees This rotates a print image as specified. 
 The rotated print image is printed as a graphics image, 
therefore, the Device fonts, control font, and controlA font 
cannot be used.

Rotate by 180 Degrees

Rotate by 270 Degrees

Reduced Size Print *

This configures reduced print, [Fit to Printable Width] or 
[Custom].
When [Reduced Print] is selected, the following message is 
displayed; "<Print all text as graphics image> will be 
automatically set to yes.". The reduced print image is 
printed as a graphics image, therefore, the Device fonts, 
control font, and controlA font cannot be used.

When Logic paper size is selected, deselecting [Reduced 
Print] automatically changes the paper size to Paper size 
or User Defined Paper Size.

Fit to Printable Width
A print image is automatically scaled down so that it fits 
inside the width of the paper loaded on the device.

Custom You can manually set the reduction percentage.

Setting Description
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User defined paper size.

Allows the users to define custom paper sizes. Up to 30 sizes can be saved as the User Defined 

Paper Sizes. 
In the Printing Preferences ‐ [Layout] tab, select [User Defined Paper Size] from the Paper Size 

pull‐down menu. The following screen appears.

Setting Description

Paper Size

This shows the list of saved User defined paper sizes.

"To define a new custom size, select "User Defined Paper Size". 

When one of the saved custom sizes is selected from the list, the configured 
[Paper Size name], [Paper Width], and [Paper Length] are displayed and 
you can edit the setting. 

Paper Size Name

An arbitrary name of each custom paper size can be specified using up to 
24 characters. 

You can not use the name of the physical paper sizes, already shown in the 
Paper Sizes list in [Layout] tab.

Paper Width Specifies a paper width. 

Paper Length Specifies a paper length.

Delete Paper Size Deletes a selected custom paper size shown in the list.

Save Paper Size

Saves a configured custom paper size.
The information of [Paper Size Name], [Paper Width], and [Paper Length] will 
be saved.

If you edit the existing User defined paper size and click this button, the 
setting is overwritten.

OK Saves the selected User Defined paper size.

Cancel Cancels changes made on an existing User Defined paper size.
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Water Mark

Allows you to set a bitmap file to be used as a Water Mark. The preview window shows the 

specified Water Mark image reflecting the selected Print Position, Size, and Density. 

Setting Description

Water Mark

Tick the checkbox to set a Water Mark. 

The following message is displayed; "<Print all text as graphics image> will be 
automatically set to yes.". When Water Mark is enabled, the print image is 
printed as a graphics image, therefore, the Device font is replaced with 
TrueType font, and control font and controlA font cannot be used. 

Bitmap Specifies a bitmap file to be used as a Water Mark.

Print Position

Select a desired print position from the pull-down menu.

The following position settings are provided: Top Left/Top Center/Top Right/
Middle Left/Middle Center/Middle Right/Bottom Left/Bottom Center/Bottom 
Right/Tiled

Size

Configures the size of Water Mark in a percentage of print area. The 
percentage can be specified within the range of 0 to 100. However, if you 
select "0", the Water Mark becomes too small and cannot be printed. 

When "100" is specified, the Water Mark will be enlarged or reduced so that it 
fits in the print area of the selected paper. However, depending on the 
horizontal to vertical ratio of the Water Mark image, such as a vertically long 
image, some portions of the image may exceed the print area and may not 
be printed. The length of paper is not changed according to the length of 
the Water Mark image.

Density
Configures the density of the Water Mark. The density can be adjusted in the 
"Light" to "Dark" range. 
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Document Settings

The Document Settings allows you to configure the document property. In the upper area of the 

window, the setting items are displayed in a tree view format, and the current settings of each 

setting items are shown on the right. If you select a setting item, the setting options for the 

selected item are displayed in the lower box. 

If the connected product does not have the function, the corresponding setting item is not 

displayed. 

Setting item

Setting box
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Paper Conservation
You can save paper by skipping page margins. Printing in the Windows environment is made 

based on standard paper sizes, such as A4, A5 size. Therefore, regardless of whether print data 

has been received or not, paper is advanced automatically by a predetermined amount each time 

after a receipt is printed. This function allows you to save paper by disabling the automatic 

paper feeding. 

Setting Description
None Does not save paper.

Top Skips the margin from the beginning of printing to the first print data.

Bottom (Default) Skips the margin from the last line of the printout to the auto cut point.

Top & Bottom
Skips both margin from the beginning of printing to the first print data and 
margin from the last line of the print to the auto cut point.

According to the Rotate setting in the Layout tab, the Paper Conservation setting is 

automatically set as follows. 
When the Rotate setting is set to "Normal" or "Rotate by 90 Degrees", the Paper 

Conservation is set to "Bottom". When "Rotate by 180 Degrees" or "Rotate by 270 

Degrees" is specified, the Paper Conservation is set to "Top". 
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Print all text as graphic images
All the data will be printed as a graphic images.

* When this setting is changed to "Yes" because of other settings, a message appears to notify you of the change. 

Setting Description

Yes

All print data is printed as a graphics image. 
The computer creates the print data in the same way as Windows driver does, 
therefore, the print data size becomes larger. In addition to that, Device fonts are 
replaced with TrueType fonts, and Device fonts are not displayed in the Font tab.

No * (Default)

Device fonts are printed. 
The product creates the print data, therefore, the data size becomes smaller. In 
addition to the Device fonts, you can also use control font, and controlA font. Due 
to some settings, you may not be able to change the setting from "Yes" to "No". In 
such case, a message appears to notify you of the setting that prevents the 
change. 

"If you select "Yes", you can not use device font / control font / controlA font.
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Related PDS settings.

The following settings automatically change this setting to ʺYesʺ.

Input Unit
The unit to express a length in the Property screen can be changed. Paper size or any other length 

settings are expressed in the selected unit in the user interface.

Related PDS settings.

Setting tab Item

Layout
Rotate

Reduced print

Water Mark Water Mark

Barcode

Add Quiet Zone

Rotation

Composite (when not installed on the device)

Type (when not installed on the device)

2D-Code

Add Quiet Zone

Rotation

Type (when not installed on the device)

Setting Description

0.1mm (Default)
The length settings in the user interface can be made in increments of 
"0.1mm".

0.01inch
The length settings in the user interface can be made in increments of 
"0.01inch".

Setting tab Item

Layout
Paper Size (User Defined Paper Size : Paper Width, Paper Length)

Adjust Print Position (Vertical Direction, Horizontal Direction)

Barcode Element Height



72

Paper Source
This setting allows you to select operations of the autocutter and paper feed between pages, and 

between print jobs. 

Setting Description

Document[Feed,Cut]

The paper is advanced and cut each time a print job is finished. 

Document[Feed,No Cut]

The paper is advanced, but not cut each time a print job is finished. 

Document[No Feed,Cut]

The paper is cut, but not advanced each time a print job is finished.  

Because of the space between the autocutter and the print head (1 
to 2 cm, depends on the product model), a minimum top margin is 
provided even if you set the top margin to 0. To avoid the waste, this 
setting allows you to print the top of the next page (e.g. store logos) 
on the bottom of the previous page and then cut the paper without 
advancing it. In this way, the top margin created by the physical 
space of the product can be used. 

Document[No Feed,No Cut]

The paper is not advanced and not cut each time a print job is 
finished. 

Custom setting window
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Page[Feed,Cut]

The paper is advanced and cut each time a page is printed. 

Page[Feed,No Cut]

The paper is advanced, but not cut each time a page is printed. 

Page[No Feed,Cut]

The paper is cut, but not advanced each time a page is printed. 

Custom
Use this setting when printing on black mark papers or labels. 
When this is selected, the Custom setting screen appears. 

Setting Description
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Custom

When ʺCustomʺ is selected from the Paper Source list for printing on black mark papers, labels 

or cut sheets of paper, the Custom setting screen appears.

Setting Description

Feed paper to the print starting position

Specifies whether to advance labels or black mark 
papers to the print start position. When this box is 
checked, the paper is advanced to the start position. 
When not checked, the paper is not advanced. 

Paper feed

Specifies the amount of paper to be advanced. When 
a positive value is specified, the paper is fed in the print 
direction. When 0 is specified, the paper is not 
advanced. When a negative value is specified, the 
paper is fed in the direction opposite to the print 
direction.

Eject single-cut sheets

Specifies whether to send a form feed command when 
using cut sheets. When this box is checked, the 
command is sent. When not checked, the command is 
not sent.

Feed to cut position before cutting

Specifies whether to advance the paper to the cut 
position before cutting operation. When this box is 
checked, the paper is advanced to the cut position. 
When not checked, the paper is not advanced.

Cutting method

Select the cutting operation.

 Do not cut

 Cut

 Feed to black mark and do not cut

 Feed to black mark and cut
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Printing Speed
You can change the print speed (paper feed speed), if that of your product is changeable.  

When a large bitmap is printed using a thermal device with the print speed set to higher, the 

data transmission may not be able to keep up with the print speed. This can cause the device to 

pause during printing. Should this occur, the bitmap may not be printed correctly. 

Adjust the print speed by changing the setting to 1st (fast), then 2nd (slightly slower), and then 

3rd (slowest) in that order, until the image is printed properly without causing the device to 

pause. 

Setting Description
Use the printer setting.

(Default)
The print speed set at the product is applied. 

1st to maximum 
(slowest)

1st is the fastest, and the maximum is the slowest.
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Speed for printing pages that include a barcode or 2D symbol
When ʺPrint all text as graphic imagesʺ is enabled, you can set the printing speed lower for the 

pages that include barcode or 2D symbol.

Large device font smoothing
Large device fonts can be clearly and neatly printed. 

Setting Description
Use the printer setting.

(Default)
The print speed set at the product applied. 

1st to maximum 
(slowest)

1st is the fastest, and the maximum is the slowest.

Setting Description
Enable (Default) Performs smoothing of the large Device fonts to print them neatly.

Disable The corners of large device fonts may be printed with jaggies. 
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Cash drawer
You can configure the setting for opening the Cash drawer. A command for opening the Cash 

drawer is sent to the drawer connected to the product through the DK connector. See the Cash 

drawer specifications to check the connector number for the Cash drawer. 

Setting Description

Cash drawer #1 [2pins]

Do not open (do not send command)

(Default)
The drawer does not open.

Open before printing
The drawer opens when printing 
starts.

Open after printing
The drawer opens when printing is 
finished.

Cash drawer #2 [5pins]

Do not open (do not send command)

(Default)
The drawer does not open.

Open before printing
The drawer opens when printing 
starts.

Open after printing
The drawer opens when printing is 
finished.
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Send command
ESC/POS commands can be sent to the product directly. 

ESC/POS commands are not open to the public. Ask your sales representative for more 

information.

Setting Description

Start of Document
End of Document

Start of Page
End of Page

Send command Check this box to send a command when printing. 

Command

Enter a desired ESC/POS command to be sent to the 
product. 

You cannot enter the command without checking the 
"Send command" box. 
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Logo Printing
A desired logo can be specified to be printed. 

Setting Description

Start of 
Document

End of Document
Start of Page
End of Page

Do not print logo

(Do not send 
command)

Does not print a logo. 

Select Image file for 
use

Prints a logo using an image file. 

File
Specify an image file. The following file types are 
available:  Bmp, jpeg, gif, and png.

Print Position
Specify a logo print position. 

Select Left, Center, or Right.

Size
Specify the logo size for printing. Refer to the layout 

displayed in the preview window.

Logo registered in 
the printer 

Print a logo registered in the product.

NV graphics
Specify an NV graphic registered using the TM Flash 
Logo Setup Utility.

Key code Enter the key code of the logo that you want to print.

Print 
Position

Specify a logo print position. 

Select Left, Center, or Right.

Pop-up window when Select 
image file for use is selected

Pop-up window when logo registered in the printer is selected
NV graphics
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Option buzzer
Set the pattern and number of times the buzzer sounds for the built‐in buzzer and external 

buzzer.

Setting Description

Start of Document
End of Document

Start of Page
End of Page

Do not sound the buzzer
(do not send command)
(Default)

Do not sound the buzzer.

Sound built-in buzzer Sound the built-in buzzer in the product 

Frequency

Specify the buzzer frequency.

The frequency can be selected from the 
following: 4kHz, 440kHz and 880Hz.

Count
Specify the number of times the buzzer sounds.
Any number from 1 to 63 can be specified.

Screen when "Sound built-in buzzer" 
is selected
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Halftone Settings

Allows you to select the color treatment and dither type to print color graphics with a 

single‐color. The brightness of the image data can be specified for thermal printers.

Setting Description

Dither Type

Defines the dithering algorithm. Depending on the dither type 
selected, the image is displayed with a different pattern of 
dots. The following 4 options are available.

 Dispersed Ordered Dither

 Clustered Ordered Dither

 Error Diffusion

 Threshold

Brightness

(A function dedicated for the 
printer driver for thermal printers)

Sets the brightness of image data. Dots are displayed based 
on the arrangement set by [Brightness].
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Printer Settings

Allows you to make settings of the device. The setting items are displayed in the upper box of 

the Printer Settings screen. If you select a setting item, the setting options for the selected item 

are displayed in the lower box. 

Setting item

Setting box
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RePrint
To reprint the document printed most recently, hold down both the [Feed] button and the [3sec.] 

button on TM‐S9000 simultaneously.

Only TM‐S9000RollPaper supports this function.

Setting Description
Enable Set to Enabled.

Disable Set to Disbaled.
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TrueType Font Substitution
Allows you to replace TrueType Font with Device font, Barcode font, 2D‐Code font, control font, 

or controlA font.  

TrueType Font Substitution settings

Allows you to configure TrueType substitution settings. In the case that Device fonts cannot be 

used, the substitution setting is ignored and TrueType fonts are printed as they are. 

Setting Description

Substitute (Default)
Replaces TrueType font with Device font, Barcode font, 2D-Code font, 
control font, or controlA font. 

Do not Substitute Does not replace the TrueType font.

Advanced settings
Displays the "TrueType Font Substitution" screen. 

This button is enabled when the "Replace" is selected. 

Setting Description

TrueType Font
Displays the TrueType font list. Select TrueType fonts to be 
replaced. 

TrueType Font for substitution Displays the fonts selected by the "TrueType Font" list.

Device Font Name
Specify the device fonts to be replaced, 
"Barcode","Control","ControlA" and "2D-Code".

Substitute All
Replace all the TrueType Font on the "TrueType Font" list to the 
fonts selected on [Device Font Name]. If you put a check mark 
next to this item, [TrueType Font] will be grayed out.
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Language for displaying properties
Allows you to select from 24 languages for text on screen and help dialog.

Setting Description

Select language

Select a language from the pull-down list for text on screen and help 
dialog. You can select from the following 24 languages.

English, Japanese, Chinese-Simplified, Korean, Chinese-Hongkon, 

Croatian, Czech, Hungarian, Slovenian, Russian, Danish, Dutch, 

Finnish, French, German, Italian, Norwegian, Portuguese, Spanish, 

Swedish, Turkish, Thai, Vietnamese, Chinese-Traditional
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Barcode

Allows you to configure Barcode fonts. The Barcode type and size can be registered. Up to eight 

types of Barcodes (Barcode 1 to 8) can be registered using the PDS. 

Setting Description

Font Name
Select a desired Barcode font from the pull-down list. 
The point value changes according to the height of the element. 

Alias

An alias name can be specified for the selected Barcode font. Up to 31 
characters can be entered. Alphanumeric characters, spaces, and 
the following symbols can be used. 

Available characters: !"#$%&'()*+,-./:;<=>?@[\]^_`{|}~

Type

Select a desired Barcode type from the pull-down list (UPC-A, UPC-E, 
JAN13 (EAN), JAN8 (EAN), Code39, ITF, Codabar, Code93, Code128, 
GS1-128, GS1 DataBar Omni-directional, GS1 DataBar Truncated, 
GS1 DataBar Expanded, GS1 DataBar Limited. Select "Not Use" when 
not specifying the Barcode type. 

Advanced settings
Displays the Barcode advanced setting screen that allows you to select 
the Barcode size, HRI characters and so on. 

Settings Displays the Barcode font settings. 
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Barcode advanced setting
The Barcode advanced setting screen is displayed by clicking the Advanced settings button. This 

allows you to select the Barcode size, HRI characters and so on. 

Setting Description

Composite
Generates a GS1 composite symbol. Type selection between 
CC-A, CC-B or CC-C is automatically done based on the data. 

Element Width

Specify the width of thin elements by the number of dots. 
The settable range is between 2 to 6. The width of a barcode is 
determined with this value and the number of characters in the 
barcode. If the width of the barcode becomes wider than the 
printable area of the paper, the barcode cannot be printed or 
may be printed even out of the area.

Element Height

Specify the height of elements by the number of dots. 
The settable range is between 1 to 255 (unit: dot). The specified 
dots is displayed in the actual size (mm, the number of points) 
when printed.

HRI Position
Specifies the position of the HRI characters (Barcode data) from 
the pull-down list (Do not print, Above the Barcode, Below the 
Barcode, Both above and below the Barcode). 

HRI Font

Specifies the font of the HRI characters from the pull-down list 
(FontA, FontB). 
This option is grayed out when "No printing" is selected in the [HRI 
Position]. 
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Rotation

Specifies the print direction of Barcode. When other than 
"Normal" is selected in the Rotation setting, the following 
message is displayed: "<Print all text as graphics image> will be 
automatically set to yes."

When other than "Normal" is specified for the Rotation setting 
both in the [Layout] tab and the [Barcode] - [Advanced 
settings], the both settings are applied to the printed Barcode at 
a time.

Normal Prints the Barcode without rotating it. 

Rotate by 90 
Degrees

Rotates the Barcode to print it. The whole print data is printed as 
a graphics image, therefore, the Device fonts, control font, and 
controlA font cannot be used.

Rotate by 180 
Degrees

Rotate by 270 
Degrees

Hex lnput Mode
Allows the Barcode characters to be entered in binary. 

Ex : "00010203"  0x00 0x01 0x02 0x03

Add Quiet Zone

Check this box to add a quiet zone, the blank margin on either 
side of a Barcode, required to be properly read by a Barcode 
reader. The quiet zone is added without changing the Barcode 
position. 

Test 

Printing

Prints a set Barcode as test printing.

Test Data Inputs data for test printing.

Run Prints input data.

Setting Description
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2D-Code

Allows you to configure 2D‐Code fonts. The 2D‐Code type and size can be registered. Up to 

eight types of Barcodes (2D‐Code 1 to 8) can be registered using the PDS. 

Setting Description

Font Name
Select a desired 2D-Code font from the pull-down list. The point value 
changes according to the height of the 2D-Code. 

Alias

An alias name can be specified for the selected 2D-Code font. 
Up to 31 characters can be entered. Alphanumeric characters, 
spaces, and the following symbols can be used. 

Available characters: !"#$%&'()*+,-./:;<=>?@[\]^_`{|}~

Type

Select a desired 2D-Code type from the pull-down list (PDF417, 
QR Code, Maxi Code, GS1 DataBar Stacked, 
GS1 DataBar Stacked Omni-directional, GS1 DataBar Expanded      
Stacked). Select "Not Use" when not specifying the type. .

Advanced settings
Displays the 2D-Code advanced setting screen that allows you to make 
the detailed settings for each type of the 2D-Code. 

Settings Displays the current 2D-Code font settings. 
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2D-Code advanced settings
The 2D‐Code advanced setting screen is displayed by clicking the Advanced settings button. 

PDF417

Setting Description

Column
Specifies the number of columns of PDF417 to be printed. 
The setting can be changed within the range of 0 to 30. 

Steps
Specifies the number of steps of PDF417 to be printed. 
The setting can be changed within the range of 0 to 30. 

Module Width
Specifies the cell (module) width of PDF417 to be printed. 
The setting can be changed within the range of 2 to 8. 

Module Height
Specifies the cell (module) height of PDF417 to be printed. 
The setting can be changed within the range of 2 to 8. 

Error Correction Level
Specifies the error correction level for PDF417 (Level 0 to 
Level 8). 

Simple PDF Specifies the option of PDF417 to be printed. 
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Rotation

Specifies the print direction of 2D-Code. When other than 
"Normal" is selected in the Rotation setting, the following 
message is displayed: "<Print all text as graphics image> will 
be automatically set to yes."

When other than "Normal" is specified for the Rotation setting 
both in the [Layout] tab and the [2D-Code] - [Advanced 
settings], the both settings are applied to the printed 2D-
Code at a time. 

Normal Prints the 2D-Code without rotating it. 

Rotate by 90 Degrees Rotates the 2D-Code to print it. The whole print data is 
printed as a graphics image, therefore, the Device fonts, 
control font, and controlA font cannot be used.

Rotate by 180 Degrees

Rotate by 270 Degrees

Hex Input Mode
Allows the 2D-Code characters to be entered in binary. 

Ex : "00010203"  0x00 0x01 0x02 0x03

Add Quiet Zone

Check this box to add a quiet zone, the blank margin 
around the 2D-Code, required to be properly read by a 2D-
Code reader. The quiet zone is added without changing the 
2D-Code position. 

Test 
Printing

Prints a set PDF417 as test printing.

Test Data Inputs data for test printing.

Run Prints input data.

Setting Description



92

QR Code

Setting Description
Model Specifies a QR Code model (Model1 or Model 2). 

Module Width
Configures the cell (module) of QR Code to be printed. The 
setting can be changed within the range of 1 to 16. 

Version

Specifies the QR Code version. 
Depending on the QR Code version, the number of 
characters to be used for the 2D-Code changes. 
The settable versions are 1 to 16 when the "Model 1" is 
selected in the [Model], and 1 to 40 when the "Model 2" is 
selected. 

Error Correction Level
Specifies the error correction level for QR Code (Level L, 
Level M, Level Q, Level H). 

Rotation

Specifies the print direction of 2D-Code. When other than 
"Normal" is selected in the Rotation setting, the following 
message is displayed: "<Print all text as graphics image> will 
be automatically set to yes."

When other than "Normal" is specified for the Rotation setting 
both in the [Layout] tab and the [2D-Code] - [Advanced 
settings], the both settings are applied to the printed 2D-
Code at a time. 

Normal Prints the 2D-Code without rotating it. 

Rotate by 90 Degrees Rotates the 2D-Code to print it. The whole print data is 
printed as a graphics image, therefore, the Device fonts, 
control font, and controlA font cannot be used.

Rotate by 180 Degrees

Rotate by 270 Degrees

Hex Input Mode
Allows the 2D-Code characters to be entered in binary. 

Ex : "00010203"  0x00 0x01 0x02 0x03
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Add Quiet Zone

Check this box to add a quiet zone, the blank margin 
around the 2D-Code, required to be properly read by a 2D-
Code reader. The quiet zone is added without changing the 
2D-Code position. 

Test 

Printing

Prints a set QR Code as test printing.

Test Data Inputs data for test printing.

Run Prints input data.

Setting Description
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Maxi Code

Setting Description

Mode
Specifies Mode (2 to 6) of Maxi Code.
Check the [Hex Input Mode ] box when specifying "Mode2" 
and "Mode3".

Rotation*

Specifies the print direction of 2D-Code. When other than 
"Normal" is selected in the Rotation setting, the following 
message is displayed: "<Print all text as graphics image> will 
be automatically set to yes."

When other than "Normal" is specified for the Rotation setting 
both in the [Layout] tab and the [2D-Code] - [Advanced 
settings], the both settings are applied to the printed 2D-
Code at a time. 

Normal Prints the 2D-Code without rotating it. 

Rotate by 90 Degrees Rotates the 2D-Code to print it. The whole print data is 
printed as a graphics image, therefore, the Device fonts, 
control font, and controlA font cannot be used.

Rotate by 180 Degrees

Rotate by 270 Degrees

Hex Input Mode
Allows the 2D-Code characters to be entered in binary. 

Ex : "00010203"  0x00 0x01 0x02 0x03

Add Quiet Zone

Check this box to add quiet zone, the blank margin around 
the 2D-Code, required to be properly read by a 2D-Code 
reader. The quiet zone is added without changing the 2D-
Code position. 

Test 

Printing

Prints a set Maxi Code as test printing.

Test Data Inputs data for test printing.

Run Prints input data.
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GS1 DataBar Stacked

Setting Description
Composite Adds a composite symbol to a two-dimensional symbol.

Module Width
Specifies the cell (module) width of GS1 DataBar Stacked to 
be printed. 
The setting can be changed within the range of 2 to 8. 

Rotation*

Specifies the print direction of 2D-Code. When other than 
"Normal" is selected in the Rotation setting, the following 
message is displayed: "<Print all text as graphics image> will 
be automatically set to yes."

When other than "Normal" is specified for the Rotation setting 
both in the [Layout] tab and the [2D-Code] - [Advanced 
settings], the both settings are applied to the printed 2D-
Code at a time. 

Normal Prints the 2D-Code without rotating it. 

Rotate by 90 Degrees Rotates the 2D-Code to print it. The whole print data is 
printed as a graphics image, therefore, the Device fonts, 
control font, and controlA font cannot be used.

Rotate by 180 Degrees

Rotate by 270 Degrees

Hex Input Mode
Allows the 2D-Code characters to be entered in binary. 

Ex : "00010203"  0x00 0x01 0x02 0x03

Add Quiet Zone

Check this box to add a quiet zone, the blank margin 
around the 2D-Code, required to be properly read by a 2D-
Code reader. The quiet zone is added without changing the 
2D-Code position. 

Test 
Printing

Prints a set GS1 DataBar Stacked as test printing.

Test Data Inputs data for test printing.

Run Prints input data.
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GS1 DataBar Stacked Omni-directional

Setting Description
Composite Adds a composite symbol to a two-dimensional symbol.

Module Width
Specifies the cell (module) width of GS1 DataBar Stacked 
Omni-directional to be printed. 
The setting can be changed within the range of 2 to 8. 

Rotation*

Specifies the print direction of 2D-Code. When other than 
"Normal" is selected in the Rotation setting, the following 
message is displayed: "<Print all text as graphics image> will 
be automatically set to yes."

When other than "Normal" is specified for the Rotation setting 
both in the [Layout] tab and the [2D-Code] - [Advanced 
settings], the both settings are applied to the printed 2D-
Code at a time. 

Normal Prints the 2D-Code without rotating it. 

Rotate by 90 Degrees Rotates the 2D-Code to print it. The whole print data is 
printed as a graphics image, therefore, the Device fonts, 
control font, and controlA font cannot be used.

Rotate by 180 Degrees

Rotate by 270 Degrees

Hex Input Mode
Allows the 2D-Code characters to be entered in binary. 

Ex : "00010203"  0x00 0x01 0x02 0x03

Add Quiet Zone

Check this box to add a quiet zone, the blank margin 
around the 2D-Code, required to be properly read by a 2D-
Code reader. The quiet zone is added without changing the 
2D-Code position. 

Test 
Printing

Prints a set GS1 DataBar Stacked Omni-directional as test 
printing.

Test Data Inputs data for test printing.

Run Prints input data.
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GS1 DataBar Expanded Stacked

Setting Description
Composite Adds a composite symbol to a two-dimensional symbol.

Module Width
Specifies the cell (module) width of GS1 DataBar Expanded 
Stacked to be printed. 
The setting can be changed within the range of 2 to 8. 

Maximum Width
Specifies maximum width of GS1 DataBar Expanded 
Stacked to be printed. 
The setting can be changed within the range of 106 to 3952. 

Rotation*

Specifies the print direction of 2D-Code. When other than 
"Normal" is selected in the Rotation setting, the following 
message is displayed: "<Print all text as graphics image> will 
be automatically set to yes."

When other than "Normal" is specified for the Rotation setting 
both in the [Layout] tab and the [2D-Code] - [Advanced 
settings], the both settings are applied to the printed 2D-
Code at a time. 

Normal Prints the 2D-Code without rotating it. 

Rotate by 90 Degrees Rotates the 2D-Code to print it. The whole print data is 
printed as a graphics image, therefore, the Device fonts, 
control font, and controlA font cannot be used.

Rotate by 180 Degrees

Rotate by 270 Degrees

Hex Input Mode
Allows the 2D-Code characters to be entered in binary. 

Ex : "00010203"  0x00 0x01 0x02 0x03

Add Quiet Zone

Check this box to add a quiet zone, the blank margin 
around the 2D-Code, required to be properly read by a 2D-
Code reader. The quiet zone is added without changing the 
2D-Code position. 
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Test 
Printing

Prints a set GS1 DataBar Expanded Stacked as test printing.

Test Data Inputs data for test printing.

Run Prints input data.

Setting Description
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Font

The device fonts; supported by product, their points, and the code pages are listed.

An alias can be specified for a device font in the printer font advanced settings.

 In addition, alias names can be specified to the device fonts. When using device fonts, specify 

their points in ʺSupported Printer Fonts and Font Sizesʺ. When programming, designate the 

fonts and their points specified here.

Setting Description
Advanced settings Displays the Printer font advanced setting screen.

Test 
Printing

Prints the device font as test printing.

Test Data Inputs data for test printing.

Run Prints input data.

Printer font advanced setting
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Printer font advanced setting
Click the Advanced settings button to open the Printer font advanced setting screen.

Alias Setting

Specify an alias for a device font. This allows you to print using a device font without changing 

the application font name.

Setting Description

Modifiable printer font
The device fonts to which their alias names can be specified are 
displayed.

Printer font name to be set The fonts selected from the "Modifiable printer font" list are displayed.

Specify alias name Specify an alias name.
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Printer Font Substitution

Specify a TrueType font to be substituted for a device font. Printer font substitution is possible 

when ʺPrint all text as graphic imagesʺ is set to ʺYesʺ in the [Document Settings] tab of [Printing 

Preferences].

Setting Description
Printer font list Lists the replaceable device fonts.

Printer font to substitute The font selected in the "Printer font list" appears.

Font form to substitute Specify the substitute font.
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Register Emulation Font

Specify the font name, font size (height and width in dots), and font design (TrueType font). Set 

this to change a font name and size.

Setting Description
Emulation font list A list of the registered emulation fonts appears.

Emulation font to register Specify the emulation font name to register.

Width Specify the width in dots.

Height Specify the height in dots.

Font form to substitute Specify the substitute font from the pull-down list.
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TM Flash Logo Setup Utility Ver.3
This chapter explains how to store logos and how to use TM Flash Logo Setup Utility Ver.3. 
TM Flash Logo Setup Utility Ver.3 allows users to print and delete the logos stored in the device 

but not to edit, restore or save them in a file format.

Storing Logos
Follow the procedure below to save your logo file to the NV memory.

1 Prepare your logo file.
A size of 2047 (W) x 831 (H) dots ([Key-code Nonuse Mode (not recommended)]: 1023 (W) x 288 
(H) dots) or less can be specified, and the format can be bmp, jpeg, gif or png.

2 From the printer driver properties, select [Utility]-[EPSON Flash Logo].
The [TM Flash Logo Setup Utility Ver.3] screen appears. 

3 Click the [Add] button.
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4 Specify the image data to be used as a logo.
If the logo width is greater than the paper width (greater than 512 dots for 80 mm width, or 
greater than 360 dots for 58 mm width), a warning message will appear. Click the [OK] button 
and reduce the logo size in the [Logo Edit] screen of step 5.

5 The [Logo Edit] screen appears. 
Edit the logo image while checking the image previewed on the upper 
portion of the screen. When finished, click the [OK] button.

You can edit the followings.

Setting Description

Resize
Specifies whether or not the image is resized. If the image width is 
greater than the paper width and resizing is not specified, the part of 
the image that exceeds the paper width will be cut off.

Width Specifies the width to which the image is resized (in mm).

Half toning Configures the halftone setting of the image.

Brightness Configures the brightness of the image. Select from 5 levels.
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6 The logo data is added on the list. When storing multiple logo data, 
repeat Step 3 through 5.

7 After storing all the logo data to be added to the device, check the 
indicator on the right side of the screen to see if the data size is 
acceptable to be stored on the device, and then click the [Store to 
Printer] button.

8 The logo data is stored to the device.
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Reference
This section explains about the settings of TM Flash Logo Setup Utility. 

Setting Description
Add Adds the logo data.

Edit Edits the halftone and brightness settings of the selected logo data.

Delete
Deletes the selected logo data from the list or deletes logos stored on 
the device.

Test print Prints the selected logos.

Change Logo Mode

Displays “Select Mode for Storing Logo” screen to allow you to 
change the setting mode of the [Storing Logos]. The current setting is 
displayed below [Storing Logos].

First Key-code 
Selection Mode

Specifies the logo identifying code.

Printer Driver for 
TM-S Ser ies  Contro l  
Font Setting Mode

The Printer Driver for TM-S Series allows you to assign a control font (h 
to l) to your logo instead of using a key code.
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Key-code Management

You can check the Key-code of the logo stored in the device, or 
delete the logos.

Preview
Displays the logo image to be stored on the device. Logo images 
stored on the device are not displayed.

Save to File
Saves the configured logo data as a file to store it to the device. 
The data can also be stored as a bmp file.

Store to Printer Stores the configured logo data to the device.

Setting Description
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Printer Specification
This book explains the setting items of Device Font, Control Font, ControlA Font, Resolution, 

Paper Size, Rotate, Reduce, Water Mark, and command ID.

 Some settings are not available for some printer models.
 Administrator permission is required for property settings of the printer driver.

Item Description

Driver Name EPSON TM-S9000 CutSheetPaperEN

Device Font Prohibited when rotation is selected.
Prohibited when resizing a font in a smaller size or when Water Mark is selected.

FontA11 FontA12 FontA21 FontA22 FontA24 FontA42
FontA44 FontA48 FontA84 FontA88 FontB11 FontB12
FontB21 FontB22 FontB24 FontB42 FontB44 FontB48
FontB84 FontB88
Code Page WPC1252

FontA11[255] FontA12[255] FontA21[255] FontA22[255] FontA24[255] FontA42[255]
FontA44[255] FontA48[255] FontA84[255] FontA88[255] FontB11[255] FontB12[255]
FontB21[255] FontB22[255] FontB24[255] FontB42[255] FontB44[255] FontB48[255]
FontB84[255] FontB88[255]
 Space Page (255)

Barcode Font Not supported.

2D-Code Font Not supported.

Control Font Font Name : control , Point : 1
 No operations for characters other than those mentioned above.
 Prohibited when rotation is selected.
 Prohibited when resizing a font in a smaller size or when Water Mark is selected.

Char Function Char Function

4 Transmits FF j NV graphics 2 printing (48,50)

5 Transmits HT k NV graphics 3 printing (48,51)

6 Transmits LF l NV graphics 4 printing (48,52)

7 Transmits CR w Position alignment left

a Open Drawer 5pin(50ms) x Position alignment center

b Open Drawer 5pin(100ms) y Position alignment right

c Open Drawer 5pin(150ms) A Open Drawer 2pin(50ms)

d Open Drawer 5pin(200ms) B Open Drawer 2pin(100ms)

e Open Drawer 5pin(250ms) C Open Drawer 2pin(150ms)

h NV graphics 0 printing (48,48) D Open Drawer 2pin(200ms)

i NV graphics 1 printing (48,49) E Open Drawer 2pin(250ms)

ControlA Font Font Name : controlA , Point : 1
 Characters defined by ControlA Font Character Translation Table. 
 No operations for characters not defined. No printing for spaces.
 No paper feeding for any functions that do not include paper feeding.
 Prohibited when rotation is selected.
 Prohibited when resizing a font in a smaller size or when Water Mark is selected.

Resolution 180x180DPI
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Paper Size 235mm x 86mm
Paper Size 235mm x 86mm (1665dot x 609dot)
Printing Width 214.9mm (1523dot)
Margin top 17.1mm(121dot) bottom 18.1mm(128dot)

left 10.0mm(71dot) right 10.0mm(71dot)
213mm x 86ｍｍ

Paper Size 213mm x 86mm (1509dot x609dot)
Printing Width 192.9mm (1367dot)
Margin top 17.1mm(121dot) bottom  18.1mm(128dot)

left 10.0mm(71dot) right 10.0mm(71dot)
152mm x 70mm

Paper Size 152mm x 70mm (1077dot x 496dot)
Printing Width 131.9mm (935dot)
Margin top 1.1mm(8dot) bottom  18.1mm(128dot)

left 10.0mm(71dot) right 10.0mm(71dot)
User Defined Paper Size

Width 120.0 ~ 235.0mm, Height 70.0 ~ 120.0mm
Logic paper size (when resizing in a smaller size)

Postcard 100 x 148 mm

Rotate Normal Rotate by 90 Degrees
Rotate by 180 Degrees Rotate by 270 Degrees

Reduce Printing ON/OFF
Fit to Printable Width/Custom(10 - 100%)

Water Mark Supported
 When Water Mark is specified to the printer, the printer cannot use Device Font, Control Font 

and ControlA Font

Item Description
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Item Description

Driver Name EPSON TM-S9000 RollPaperEN

Device Font Prohibited when rotation is selected.
Prohibited when resizing a font in a smaller size or when Water Mark is selected.

FontA11 FontA12 FontA21 FontA22 FontA24 FontA42
FontA44 FontA48 FontA84 FontA88 FontB11 FontB12
FontB21 FontB22 FontB24 FontB42 FontB44 FontB48
FontB84 FontB88
 Code Page WPC1252

FontA11[255] FontA12[255] FontA21[255] FontA22[255] FontA24[255] FontA42[255]
FontA44[255] FontA48[255] FontA84[255] FontA88[255] FontB11[255] FontB12[255]
FontB21[255] FontB22[255] FontB24[255] FontB42[255] FontB44[255] FontB48[255]
FontB84[255] FontB88[255]
 Space Page (255)

Barcode Font Barcode Font Points determined. When specifying a value other than this, the Barcode is 
not printed.

Barcode1~Barcode8 Layout possible Barcode
Codabar  Code39  ITF  JAN13(EAN)  
JAN8(EAN) UPC-A  UPC-E  Code39 Code93  
Code128  GS1-128  GS1DataBar Omni-
directional  GS1DataBar Truncated  
GS1DataBar Expanded
GS1DataBar Limited

2D-Code Font 2D-Code1~2D-Code8 Layout possible 2D-Code
PDF417  QRCode  GS1 DataBar Stacked
GS1 DataBar Omni-directional
GS1 DataBar Expanded Stacked

Control Font Font Name : control , Point : 1
 No operations for characters other than those mentioned above.
 Prohibited when rotation is selected.
 Prohibited when resizing a font in a smaller size or when Water Mark is selected.

Char Function Char Function

5 Transmits HT k NV graphics 3 printing (48,51)

6 Transmits LF l NV graphics 4 printing (48,52)

7 Transmits CR w Position alignment left

a Open Drawer 5pin(50ms) x Position alignment center

b Open Drawer 5pin(100ms) y Position alignment right

c Open Drawer 5pin(150ms) A Open Drawer 2pin(50ms)

d Open Drawer 5pin(200ms) B Open Drawer 2pin(100ms)

e Open Drawer 5pin(250ms) C Open Drawer 2pin(150ms)

g No paper feeding + Partial cut D Open Drawer 2pin(200ms)

h NV graphics 0 printing (48,48) E Open Drawer 2pin(250ms)

i NV graphics 1 printing (48,49) P Paper feeding +Partial cut

j NV graphics 2 printing (48,50)

ControlA Font Font Name : controlA , Point : 1
 Characters defined by ControlA Font Character Translation Table. 
 No operations for characters not defined. No printing for spaces.
 No paper feeding for any functions that do not include paper feeding.
 Prohibited when rotation is selected.
 Prohibited when resizing a font in a smaller size or when Water Mark is selected.

Resolution 180x180DPI
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Paper Size 80mm Roll Paper
Paper Size 80mm x 297mm (566dot x2104dot)
Printing Width 72.2mm (512dot)
Margin top 0mm(0dot) bottom  0mm(0dot)

left 3.9mm(28dot) right 3.6mm(26dot)
User Defined Paper Size

Width 72.2 ~ 210.0mm, Height 25.4 ~ 3275.9mm
Logic paper size (when resizing in a smaller size)

A4 210mm x 297mm
LT. 8.5 x 11 in. 
Postcard 100 x 148 mm

Rotate Normal Rotate by 90 Degrees
Rotate by 180 Degrees Rotate by 270 Degrees

Reduce Printing ON/OFF
Fit to Printable Width/Custom(10 - 100%)

Water Mark Supported
 When Water Mark is specified to the printer, the printer cannot use Device Font, Control Font 

and ControlA Font

Item Description
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Devmode API command ID for driver
Command ID supported by drivers are as follows: 

Printer Driver
EPSON TM-S9000 Cut Sheet ✔ ✔ - ✔ - - - ✔ -

EPSON TM-S9000 Roll Paper ✔ ✔ ✔ ✔ ✔ ✔ - ✔ ✔

EPSON TM-H6000II Receipt (for TM-S9000) ✔ ✔ ✔ ✔ ✔ ✔ - ✔ -

EPSON TM-H6000II Slip (for TM-S9000) ✔ ✔ - ✔ - - - ✔ -

EPSON TM-H6000II Validation(for TM-S9000) ✔ ✔ - ✔ - - - ✔ -

EPSON TM-H6000III Receipt (for TM-S9000) ✔ ✔ ✔ ✔ ✔ ✔ - ✔ -

EPSON TM-H6000III Slip (for TM-S9000) ✔ ✔ - ✔ - - - ✔ -

EPSON TM-H6000III Slip Rotate (for TM-S9000) ✔ ✔ - ✔ - - - ✔ -

EPSON TM-H6000III Validation (for TM-S9000) ✔ ✔ - ✔ - - - ✔ -

EPSON TM-H6000IV Receipt (for TM-S9000) ✔ ✔ ✔ ✔ ✔ ✔ - ✔ ✔

EPSON TM-H6000IV Slip (for TM-S9000) ✔ ✔ - ✔ - - - ✔ -

EPSON TM-H6000IV Slip Rotate (for TM-S9000) ✔ ✔ - ✔ - - - ✔ -

EPSON TM-H6000IV Validation (for TM-S9000) ✔ ✔ - ✔ - - - ✔ -

EPSON TM-U325 Receipt (for TM-S9000) ✔ ✔ ✔ ✔ ✔ - - ✔ -

EPSON TM-U325 Validation(for TM-S9000) ✔ ✔ - ✔ - - - ✔ -

EPSON TM-U375 Receipt (for TM-S9000) ✔ ✔ ✔ ✔ ✔ - - ✔ -

EPSON TM-U375 Slip (for TM-S9000) ✔ ✔ - ✔ - - - ✔ -

EPSON TM-U375 Validation(for TM-S9000) ✔ ✔ - ✔ - - - ✔ -

EPSON TM-U675 Receipt (for TM-S9000) ✔ ✔ ✔ ✔ ✔ - - ✔ -

EPSON TM-U675 Slip(for TM-S9000) ✔ ✔ - ✔ - - - ✔ -

EPSON TM-U675 Validation(for TM-S9000) ✔ ✔ - ✔ - - - ✔ -
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Restrictions
This chapter describes the restrictions that apply to the PDS.

OS Settings
1. With Windows 8/ Windows 7/ Vista/ XP, use [Enable advanced printing features] (EMF 

spool) in the printer driver Properties ‐ [Advanced] tab set to ON. Setting otherwise (RAW 
spool) applies the following restrictions to the GDI functions:

• Raster operation cannot be printed as specified by StrtchBlt()/BitBlt().

• When  transferring bit  information  from display device  context  to  the printer device 

context using StretchBlt(), the GDI function returns ʺFailureʺ and prevents the driver 

from printing.

2. When printing multiple pages, if you change the paper orientation from one page to another 
and/or other settings using ResetDC(), the print result may be incorrect. In such cases, set 
RAW spool (with Windows XP/Vista, set [Enable advanced printing features] to OFF) 
although some restrictions apply. See the previous paragraph for the restrictions.

3. When printing a device font in Microsoft Word, the following setting is necessary.

• For Word 2003 or earlier:
From [Tools] ‐ [Options] ‐ [Compatibility], select ʺMicrosoft Word 6.0/95ʺ in 

[Recommended Options for] or make a check in ʺUse printer metrics to lay out 

documentʺ in [Options].

• For Word 2007:
From [Word Options] ‐ [Advanced] ‐ [Compatibility Options for], select ʺMicrosoft 

Word 6.0/95ʺ or  ʺCustomʺ in [Lay out this document as if created in], and make a check 

in ʺUse printer metrics to lay out documentʺ in [Layout Options].

• For Word 2010:
From [File] ‐ [Options] ‐ [Advanced] ‐ [Compatibility Options for], select ʺMicrosoft 

Word 6.0/95ʺ or  ʺCustomʺ in [Lay out this document as if created in], and make a check 

in ʺUse printer metrics to lay out documentʺ in [Layout Options].

4. If you print more than one Excel sheet at the same time when different print settings are set 
for each sheet, the setting for the last sheet is effective.

5. When printing with Microsoft ACCESS, the text in the print result may be misaligned or 
align left may not be possible.

6. Operation in a Windows XP multi‐user environment is not guaranteed.

7. When creating multiple queues and executing printing on one printer, make sure not to use 
a Microsoft standard USB port and the TMSPRT port simultaneously.
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Restrictions in the environment where redirected from a server
(Environment such as Terminal Service and  the remote desktop)

1. When printing a device font with some applications, the characters may not be printed 
completely since the print position setting may be changed. and character may not printed.

2. Functions to print by sending the print data directly to the printer, such as WritePrinter 
cannot be used.

3. The properties for the printer driver cannot be set. Setting for the server reflects in that for 
the properties.

4. The utilities in the [Utility] tab in the properties of the printer driver cannot be used.

5. Help for the printer driver is not displayed.

6. If [Substitute All] is executed by selecting the [Printer Settings] tab ‐ [TrueType Font 
Substitution] ‐ [Advanced settings] ‐ [TrueType Font Substitution] settings under the 
terminal service environment, the print result may get garbled. In such a case, replace the 
fonts individually or print it as a graphic.
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Printing
1. Print data outside of the printable area will not be printed. 

2. When printing on receipt paper, blank space appears at the top of the paper which is greater 
than the top margin setting value. This is caused by the fact that the paper cutting position 
(autocutter) and the printing position (printer head) are separated and the distance between 
them results in extra margin.

3. Device fonts cannot be used in rotated, condensed or enlarged printing. Use Windows fonts.

4. If a device font and graphics data (Windows font or ruled line, etc.) are defined on the same 
line, the print result may be misaligned.

5. Euro currency symbol cannot be printed. 

6. The paper size displayed in the printer driver Properties ‐ [General] tab may differ from 
what is stated in the ʺPrinter  Specification.ʺ In such cases, select the paper size stated in the 
userʹs manual.

7. With Windows 8/ Windows 7/ Vista/ XP, printing of codes 80H, 8EH, or 9EH from an 
application when device Font A or B, or blank page Font A or B [255] is specified may not 
operate correctly.

8. [Separator Page] in the printer driver Properties ‐ [Advanced] tab is not available.

9. With some applications, several device font size options are displayed, however, device font 
is always printed in a fixed size regardless of your size selection. 

10. With some applications, print settings such as ʺCollateʺ and ʺOrientationʺ configured on the 
application side may differ from the printer driver settings. In such cases, the settings on the 
application side take priority. However, it is not possible to print beyond the deviceʹs 
capabilities. (For example, printing in landscape format using device font)

11. Even when you specify bold or italic font settings, it will not be reflected in the printings. 
The underline is printed but the position is offset. 

12. The color format is fixed to 24 BPP. So check that dmColor setting for Devmode is set to 
ʺColorʺ on the application side.

13. When water mark and 2‐D symbol are used in a single data, the printout could be 
misaligned (displaced). 

14. When you print a narrow width Barcode with a high‐resolution device, all of the HRI 
characters may not be printed. In such case, specify narrow width fonts; FontB/C for the HRI 
characters. 
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15.  If you manually remove printed paper when the paper source selection is set to [No Eject] 
with the slip driver, the following printing will not be performed correctly.
In that case, turn off the power of the device, and then turn it on again.

16. If you print color logos with a device that does not support color printing of slip/validation/
endorsement and so on, only the black parts will be printed.
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